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Overview 

Version 2016 Revisions 

Added the ability to Import Perforated Interval Data 

Added the ability to Export Perforated Interval  

In the Well record we have added the ability to Enter the Wells Surface Location Latitude and 
Longitude in a formatted degrees minutes and seconds. 

In the Well record we have added the ability to Calculate the Wells Casing’s Latitude and Longitude 
from a measured depth if you have entered the Wells Surface Location in a formatted degrees minutes 
and seconds. 

In the Well record we have added the ability to Calculate the Wells Bottom Hole Location Latitude and 
Longitude from a measured depth if you have entered the Wells Surface Location in a formatted degrees 
minutes and seconds. 

We have added another layer to show the Perforated Intervals in Power*Log, Power*Curve and 
Power*Core. 

Added a new Open Well Window in the Survey View Module. 

Added the ability to designate the Township and Range numbers to the Plan and User defined views in 
the Survey View Module 

Added the ability to define and display and calculate the distance from hard boundaries in the Plan and 
User defined views in the Survey View Module. 

Ability to show the Power*Steer top and base of zones planes on the Survey View Modules User defined 
view. 

Added the Power*Steer Module to our long list of products. 

Added a Curve Fill Layer (Power*Steer Option on Single Curve) that allows you to create a visual effect 
with the Interpretive lithology coupled with the Power*Steer bedding dips and faults. This layer will allow 
you to automate the drafting on the Lithology along the Well Path in this track. If the Interpretive lithology 
has been drawn it will be reflected and directly correlated to the corresponding bedding dips and faults 
created in the Power*Steer application. 

Wellsite Information Transfer Specification (WITS) for Digital Rig-Site Data is now available. Log on to the 
to the WITSML Server (with the correct permissions) and you can pole the server for all your curve and 
survey data along with any or all of the relevant data that has been entered into the Electronic Drilling 
Recorder (EDR). Imagine you can now get all this data into your database and displayed on all your logs 
without having to export from the server and then import into our application. Not quite real time as you 
have to set up a polling time but you can be as little as 1 minute behind the bit. 
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File Menu – Import Menu - Perforations 
This method will allow the user to import ASCII, space, comma or tab delimited file formats into our database. We 
cannot import EXCEL or any other type of spreadsheet format. If the data comes that way you must resave it in 
another format before attempting to import the data. 

Importing Perforated Intervals Data 
1. To access the Perforation Interval Data Import window, click on Import under File to activate the pop-out menu 

and then select Perforations or click on the  Import Perforations button on the Import Toolbar. This will 
activate the open Percent Data file window as shown below. 

 
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set delimiter 
window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Perforated Intervals Import window shown below. 
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Overview of the window. 
The left hand side of the Perforated Intervals Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Perforated Intervals Import window allows the user to see the data fields associated 
with the Perforated Intervals supplied by Power*Suite. 

 Button allows the user to open another Perforated Intervals data file after the Import window has been 
opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
Perforated Intervals file to database fields in the Perforated Intervals table in the database. 

 Button allows the user to save the mapping between data columns in the Perforated Intervals file to 
database fields in the Perforated Intervals table in the database. Once the initial mapping has been done and saved, 
the user can utilize this mapping file so you do not have to repeat the clicking of dragging of data columns to 
database fields in the Perforated Intervals table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the slide data file to database 
fields in the Perforated Intervals table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Word pad to look at the file format and possibly make changes to 
the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 

Importing / Mapping of Perforated Intervals data. 
A Perforated Intervals Layer should already have been added through the Log configuration builder so that the user 
has a Perforated Intervals type layer to import to. Otherwise it would be impossible to import any data. 
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1. On the left side of the window Click and drag the data column you wish to import to the corresponding table 
field on the right side and release it when the field becomes highlighted. If mapped the field  will turn green 
on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 
2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 

mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button and giving this 
procedure a file name and folder to be used again at a later date when you would have to import this data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 

How to Import Perforated Intervals with an Existing mapping file. 
1. To access the Perforated Intervals Import window, click on Import under File to activate the pop-out menu and 

then select Perforations or click on the  button on the Import Toolbar. This will activate the Open 
Perforated Intervals file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set delimiter 
window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly the 

Example should read <column-break> between the data columns. If you see this then click on the  
button to close this window and activate the Perforated Intervals Import window shown below. 

 

4. In the upper portion of the window click on the  button. This will activate an open file window. 
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5. Select the mapping file with the *.prf saved from previous imports of similar Perforated Intervals files to your 

percent table by highlighting the file and clicking on the  button or double clicking on the file name. 
Once the file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column you 
wish to import to the field on the right side and release it when the layer becomes highlighted. 

 

7. Click on the  button. After the data has been imported you will be prompted with a system message. 

 

8. Acknowledge the Import message. Click on the  button and then click on the  to exit or click on 

the  button to close the Window. 
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File Menu – Export Menu - Perforations 
This utility exports your Perforation Intervals. This data can be exported into 3 file formats which can then be used by 
other applications. 

Exporting Perforated Interval Data 

To access the Export Perforated Interval Data window, click on Export under File to activate the pop-out menu and 

then select Perforations. You can also select the  Icon on the Export toolbar. This will activate the Specify file 
name window. 

 

1. Click on the radio button next to the type of the file that you would like to create. 

2. Click on the  button. This will activate a Specify File Name window. 

 
3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on the 

 button. This will activate the System Information window asking you if you wish to proceed. 

 

4. Click on the  button. This will create the file. 

Edit Menu - Well 
Lets you edit existing wells, and delete a well. The majority of this information is usually filled in at the start of a well, 
but should be updated with new information at the completion of a well. 
 
The information associated with each well is entered into the Well window, along with the well's UWI (Unique Well 
Identifier). Note that each well and the information that it contains must be associated with a UWI (Unique Well 
Identifier) in order to distinguish it from the other wells residing within the Power*Log / Core & Curve database. 
However, the only way in which a well’s information can then be displayed is by associating it with a log and then 
having that log open. 
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1. Click on Well, under the Edit menu selection, to activate the Well window. 

 

Note: The well window has been filled in to give you an idea of how to complete the different fields. 
2. Change or add to the different fields by typing in the fields. Certain fields have restrictions to what data they 

accept. If an error occurs while saving refer to the status bar for instructions. 

3. Click on the  button or press ALT-S and the well data that you have just entered will be saved to the 
database. 

Note: The Well Name field should be highlighted after you have clicked on the  button or press ALT-S, as an 
indication of a properly saved record. Some of the fields in the Edit Well window have character restrictions or 
mandatory requirements. Consequently, if any of these restrictions have been violated or if any requirements have 
not been met, the offending field will be highlighted and the problem will be displayed on the Status Bar, at the lower 
left hand corner of your screen. Remember to save your work again, after the problem has been rectified. 

4. If the record has been successfully saved, click on the  button, when prompted with the Shortcut Options 
system window. 

Surface Co‐Ordinates Button: 

The  Surface Co-Ordinates button allows the user to input the Longitude and Latitude for the surface location in 
either pure degrees or degrees minutes and seconds. If you fill this window in we can then calculate the casing and 
bottom hole co-ordinates with only a depth field to be filled in. 
1. Click on Well, under Edit, to activate the Well window and it will default to the active well. 

2. Click on the  surface co-ordinates button to display the Latitude and Longitude window. 
3. Then, type in the wells surface co-ordinates in Degrees for Latitude and Longitude. 

4. Or click on the  check box to enter the wells surface co-ordinates in Degrees for Latitude and 
Longitude. 
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5. Click on the  button. 

                      

Casing and Bottom Hole Co‐Ordinates Buttons: 

The  Casing and bottom Hole Co-Ordinates buttons allows the system to calculate these co-ordinates from a 
depth entry as long as the user input the Longitude and Latitude for the surface location in either pure degrees or 
degrees minutes and seconds. 
1. Click on Well, under Edit, to activate the Well window and it will default to the active well. 

2. Click on the  beside the Casing or Bottom Hole co-ordinates 
button to display the Enter Measured Depth window. 

3. Then, type in the measured depth of the wells casing or bottom hole. 

4. Click on the  check box to display the casing or bottom 
hole co-ordinates in Degrees, Minutes and seconds for Latitude 
and Longitude. 

5. Click on the  button. 
 

Curve Fill Layer (Power*Steer Option on Single Curve) 
In Power*Suite, this layer type allows you to create a visual effect with the Interpretive lithology coupled with the 
Power*Steer bedding dips and faults. This layer will allow you to automate the drafting on the Lithology along the Well 
Path in this track. If the Interpretive lithology has been drawn it will be reflected and directly correlated to the 
corresponding bedding dips and faults created in the Power*Steer application. It has been designed to take the 
interpretive lithology drawn and fill in the Interpretation for the Horizontal (Power*Curve) application. An example is 
shown below. 

 

How to Set the Power*Steer Curve Fill options 

You will need the Well Path (TVD) curve available for the user to be able to fill in the options correctly. The easiest 
way to populate the Well Path (TVD) curve with digits would be by calculating the survey points and updating the well 
path curve with the digital data. Without actual survey data generating the well path curve this layer will not work 
correctly. 

Once the curve fill layer has been added to your log the user can now utilize the curve fill layer. To set the Curve Fill 
Options the user must first make the Curve Fill Layer active. To do so the user must click on a track containing the 
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Curve Fill layer and then selecting the given Curve Fill layer from the Layer Selection List field at the far left of the 
Selection Bar. 

1. Double click anywhere within the Curve Fill or layer 
to activate the Curve Fill Options window. 

2. Click on the  button. This will 
activate a list of curves associated with this well. 

3. Click on the Well Path curve name to use so that it 
gets listed in the upper portion of the window and 

then click on the  button or double click 
on the Well Path (TVD) curve that has been 
generated by the survey data. You will now view 

the curve name below the button. 
Curve Options Portion of the Window. This information 
is pertaining to the Main Curve and its Curve attributes. 

1. Click on the Pattern Type down arrow and select 
the correct curve pattern for the main curve. The 
default is PtoP (Point to Point). 

2. Click on the Grid Type down arrow  and select 
the correct curve grid type for the main curve. The 
default is Linear. 

Fill Options Portion of the Window (1 Curve) 

3. Click on the Fill Modes – 1 Curve down arrow  
and select the Power*Steer from these options. 

4. Click on the Fill Patterns down arrow  and select 
Interpretive Lithology. 

5. Click on the  button in the Curve fill Options 
window. The window will close and the changes 
you have made will be reflected on the layer. 

Perforated Intervals Layer 
This layer allows the user to add perforated interval data to the database. These perforated intervals can be 
displayed in Power*Log, Power*Core, Power*Curve and Power*Steer. The user can define their own intervals either 
through click and drag method or typing in the intervals. The user can also import them. 

Drawing Perforated Intervals in the Perforated Intervals Track / Layer. 
1. Double click on the Perforated Intervals Track to activate the data entry window shown below. 

 
2. Define the desired interval by clicking and dragging the mouse pointer within the Perforated Intervals track. The 

interval will be drawn accordingly. 

3. The user can also type in the depths in the builder and then click on the  button. 

4. Double Click within an existing rock type interval in the Perforated Intervals layer with the  
activated and the entire interval will be filled in with the attributes that have been entered into the Fills window. 
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5. Click and drag the mouse on the track / layer close to an existing Fill (either above or below in the same column) 
with the  activated and there will be no spaces between the fills. Remember you have to be within 
¼” of the mouse pointer or screen accuracy from the previous symbol to have the snap to take effect. 

Note: Measured Depths can be viewed within the mouse pointer display box , situated to the right of the mouse 
pointer.  
Also, while dragging the mouse, the user must start and stay within the confines of the track / layer they are working 
on. If you stray outside, the interval will start flickering and will not be drawn. 

Modifying Fill Types 
To modify the display on the track the user can right click on the fill and select one of these editing options. 
Display Fill – Displays the color of the fill interval. 
Display Text – Displays the name Perforation or P. 
Display Long- Displays Perforation within the fill interval. If unchecked, displays only 
P within the fill interval. 
Opaque Text – Displays the white frame around the name of the fill interval for a better 
visibility. 
Text Options - Allows the user to determine how they want the text to be aligned and 
oriented in the Perforated interval. 
Fill Color – The Layer Configuration Display tab foreground Color will change the color 
from default black to any color you pick 

Resizing Perforated Intervals 
Mouse Pointer Method 
1. To resize an existing fills hold your Ctrl Key down on your keypad and move 

mouse pointer over the end part of the interval until it turns into a double arrow 

. 
2. Click and drag to a new depth. Remember you cannot overwrite existing intervals. 
Keypad Method 
1. Click on the perforated Interval to be resized so that it goes into the builder. 
2. Type in the new top OR base depth into the builder. 

3. Click on the  button 

Deleting a single Perforated Interval 

1. Double Click on the Perforated Interval Layer to activate the builder. 
2. Right click on the interval you wish to delete and select delete from the pop out menu. 

3. Click on the  Close button in the upper right hand corner of the builder. This will close down the 
Environment builder window. 

Deleting multiple Perforated Intervals 

1. Double Click on the Perforated Interval Layer to activate the builder. 
2. Hold the SHIFT Key down and click and drag an area within the Perforated Interval Layer and then let go of 

the shift and mouse button to activate a System Message. 

 

3. Click on the button and the corresponding Generic Category fills will be deleted. 

4. Click on the  Close button in the upper right hand corner of the builder. This will close down the 
Environment builder window. 
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Note: Every type of layer in Power*Log, Power*Core and Power*Curve has a Data Type classification. The default 

settings for the Perforated Intervals are shown below. To access this window, click on the  Layer Configuration 
button on the Toolbar, when the Perforated Interval layer is active. 

   

Survey View Module 
How to Open a set of Surveys for a well. 
1. This will activate the survey view window shown above. Click on the New Survey button on the toolbar or click on 

New Survey from the File menu selection to activate the Select Survey to Plot window. 
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2. Highlight the Well Name you wish to open by highlighting it with the mouse pointer. 

3. If you have hard boundaries that you wish to stay away from, or you have multiple wells you wish to show on 
the survey plots you will have to fill in the surface co-ordinates for the latitude and longitude. 

4. Then you will want to enable the check box and fill in the DLS coordinates or the NTS values as indicated in the 
window shown below. If your survey system does not fall into these survey systems then leave them unchecked 
and your well will be in the centre of a generic grid system as viewed in the Plan and user defined views. 

5. Then click on the  button to activate the survey view window with your surveys from this well. 

DLS Example 

    
The surface hole Longitude and Latitude fields to not have to be filled in if this is the first well to plot in the survey 
view application. Any subsequent well data to be displayed the user must fill in the surface hole well co-ordinates for 
both Latitude and Longitude in degrees minutes and seconds and we will utilize these fields to get subsequent well 
data onto the plot. If you enable the check box beside the DLS your Plan view and User-defined view will have the 
DLS grid system marked. The DLS Survey breakdown would be as follows for this example location 
09-26-001-28 W1M. Where the 09 is the Location, 26 is the Section, 001 is the township and 28 is the range and the 
1 is the meridian 

The Meters North of the South Boundary must be just that. If your survey 
plat gives you from the north boundary, then you have to subtract that 
number from 1,609.34 m to give you the meters North of South Boundary. 
The Meters East of the West Boundary must be just that. If your survey plat 
gives you from the east boundary, then you have to subtract that number 
from 1,609.34 m to give you the meters East of West Boundary. The Road 
Allowance field (these are dead areas in the DLS grid system) is 
traditionally the default value (20.12) but can in some places (30.18). The 
Township field (Values from 1 to 126) depends on the well location. It is 
necessary because we have to accommodate for correction lines if your 
well crosses those on the plan or user defined views. The Section field 
(Values 1-36) depends on the well location. It is necessary because we 
have to accommodate for road allowances if your well crosses those on the 
plan or user defined views 

6. Click on the  button. If done correctly and you have sufficient surveys you should get the survey window 
filled in with the four (4) views of your well bore. You should see something similar to one of the Survey window 
shown above. 
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NTS Example 

   
If you enable the check box beside the NTS your Plan view and User-defined view will have the NTS grid system 
marked. 
Below is an example of the NTS survey system location. Remember we are dealing with the surface location. 
a-18-D / 94-A-13 whereas a is the ¼ Unit, 18 is the Unit, D is the block, 94 is the series, A is the Area and 13 is the 
sheet. 

Fill in the surface location fields from the surface location given to you in the 
survey plat. In this NTS system we can use any corner for the measurements 
on the surface location but you must pick one from the drop box Then fill in the 
Meters from the North / South Boundary. Then fill in the Meters from the East / 
West Boundary. If you are adding multiple wells then you must also fill the 
surface hole Longitude and Latitude fields to not have to be filled in if this is the 
first well to plot in the survey view application. Any subsequent well data to be 
displayed the user must fill in the surface hole well co-ordinates for both 
Latitude and Longitude in degrees minutes and seconds and we will utilize 
these fields to get subsequent well data onto the plot. 
Fill in the surface location fields from the surface location given to you in the 
survey plat. In this NTS system we can use any corner for the measurements 
on the surface location but you must pick one from the drop box Then fill in the 

Meters from the North / South Boundary. Then fill in the Meters from the East / West Boundary. If you are adding 
multiple wells then you must also fill the surface hole Longitude and Latitude fields to not have to be filled in if this is 
the first well to plot in the survey view application. Any subsequent well data to be displayed the user must fill in the 
surface hole well co-ordinates for both Latitude and Longitude in degrees minutes and seconds and we will utilize 
these fields to get subsequent well data onto the plot. 

3. Click on the  button. If done correctly and you have sufficient surveys you should get the survey window 
filled in with the four (4) views of your well bore. You should see something similar to one of the Survey window 
shown above. 
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No Survey System 

  

If you do not enable the check boxes beside the DLS or NTS your Plan view and User-defined view will have a 
generic grid system marked and your well centre will be right in the middle of the plot. 

3. Click on the  button. If done correctly and you have sufficient surveys you should get the survey window 
filled in with the four (4) views of your well bore. You should see something similar to one of the Survey window 
shown above. 

Edit Menu - Properties 
 

 

The Properties menu item allows the user to customize the look of the views. There is 
something to note here that if you make changes to one view they all change so beware. 

1. Click on the Properties selection under the edit pull down menu or click on the Properties icon on the tool bar. 
Another way to activate this menu is to right click on the view and select the properties option from the pop out 
menu. This will activate the edit window for the survey view application as shown on the next page. 
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Overview of Properties Window 
Display Setting Tab 

 

 The Point Display Size setting allows the user to define the size of the survey points in 
the survey view displays. If the Point Display is not checked, it will also control the thickness of the line drawn to 
represent the well path. 

 The display Point check box changes the display from survey point balls with a thin line connecting the 
survey balls to a solid line view. 

 The display Prognosis check box setting turns on/off the set of surveys that made up the original 
prognosis and displays that information. These surveys have to be entered into the Prognosis portion of the survey 
report in our main applications (Log, Curve and Core) and then calculated. 

 The display Azimuth check box allows the user to turn on/off the target azimuth of 
the well that has to be entered into the Survey Report window. Ultimately, the master survey group controls this 
display. 

 The display Survey Text setting turns on/off survey indicators on the Plan view only and these 
indicators illustrate every 10th survey point in the Master survey group. 

 The display Wireframe setting changes the survey point balls from a solid color to a wire frame symbol. 

 The display Formation tops check box will turn on/off the ability to display the Formation tops 
entered into Power*Log / Curve or Core and will display the Log / Sample or Prognosed tops as indicated in the 
Formation tops window. 

 The scale check box will turn on/off the ability to display the scale 

 The grid numbers check box will turn on/off the section numerical displays on the plan and user 
defined views. 

The Grid Walls enables the user to turn on/off the 
exterior walls of the grid system. These walls are 
displayed in three (3) of the views. These walls can be 
displayed in the User-defined, Target azimuth and Cross 

section views. The walls increment is defined by the scale increment of the window. 
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 The corners check box turns on/off the corners connecting the grid walls. The ability to turn off the corners 
will mostly be used in the Vertical Section and Azimuth views if the target azimuth is tangential. 

 
This Grid Labels enables the user to control the positioning and label verbiage in two (2) of the views. These labels 
are displayed in both the Plan view and the User-defined view but cannot be controlled independently. The labels (in 
this case are North, S, East and W) are displayed in the following example. The E+ / W- axis is left / right with a + 
value moving it to the right and a – value moving it to the left. The N+ / S-  axis is up / down with a + value moving it 
up and a – value moving it down. 

 
 
The DLS Grid Rows allows the user to identify where the grid should be drawn for the 
well path on the Plan View and User defined view to be drawn. We will identify the 
Section, Township and range numbers on the views as well. Correction lines and road 
allowances are also determined with the help of the of the surface co-ordinates. The grid 
rows are indicating how many sections are required to draw in all the directions. In the 
example here the well is being drilled due north and is covering the section we are 
starting in as well as 2 more sections to the north. 
 
 

The Line Sizes enables the user to change the line thickness on the Plan and user-defined 
surface grid indications as well as the line thickness in the grid walls. Major lines encompass the 
exterior borders of a Section in the DLS system, a Unit in the NTS system and the exterior of a 
no survey system choice. All other lines on the views are minor lines. 
 
 

The Scale enables the user to control where the depth scale is positioned and 
the increment for the depth scale. The depth Scale is displayed in all 
views but the Plan view. A positive (+) value in the E+/W -field moves 
the scales to the East with a negative (-) value moves the scale to the 
West. A positive (+) value in the N+/S- field moves the scales to the 
North with a negative (-) value moves the scale to the South. The 
Increment field allows the user to specify what the wall grid increment 

will be. The check box covered earlier will turn on/off the 
scale. 
The Lithology Offset enables the user to control where the Interpretive Lithology column (displayed in TVD & 
Vertical Section) is positioned. The Interpretive Lithology column is displayed in all views but the Plan view. A positive 
(+) value in the E+/W- field moves the Interpretive Lithology to the East with a negative (-) value moves the scale to 
the West. A positive (+) value in the N+/S- field moves the Interpretive Lithology to the North with a negative (-) value 
moves the scale to the South. The Colum size field changes the width of the Interpretive Lithology displayed in the 
views. The Opacity field changes the ability to see through the column to view other data. 0 is transparent and 1 
would be solid. 

The Log Tops enables the user to control where the Formation tops are positioned.. The Log 
Tops are displayed in all views. A positive (+) value in the E+/W -field moves the scales to the 
East with a negative (-) value moves the scale to the West. A positive (+) value in the N+/S- 
field moves the scales to the North with a negative (-) value moves the scale to the South. 

The  check box covered earlier will turn on/off the scale. 
 
 

 Changes the color of the Survey Points / Line and target azimuth line display. 

 Changes the background of the entire view. 
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 Changes the text color for the blocks, labels and Formation Tops. 

Hard Boundary Portion of window. 

 

 

This portion of the window allow the user to enter any Hard boundaries that the well must stay away from. These 
boundaries can be displayed on both the Plan and User Defined views and the distance from them are calculated and 
displayed on these views. 

The  button will change the data entry method from either a Latitude / Longitude in either in strait 
degrees or degrees, minutes and seconds. Or the other method is how many meters N/S and E/W from hole center. 

The  check box will turn on/off the hard boundaries entered into the Hard Boundaries field and 
display them in the Plan and User Defined views. 
The  check box will toggle the data entry method for the hard boundaries from degrees to degrees 
minutes and seconds. 

The  field in the Hard Boundaries portion of the window allows the user to change the thickness 
hard boundary line. This field can range from 1 pixel to 7 pixels wide. 

 Changes the color of the Hard boundary lines. 
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Zone / Tops Portion of window. 

This portion of the window allows the user to display the Top and Base Zones calculated 
from the Power*Steer data. These Zone boundaries can only be displayed on the User 
Defined view. 

The Vertical Scaling field will change the scaling on all views from the normal 1:1 TVD 
/ Lateral Movement scale ratio. The example above will give you a 50:1 scale creating a 
much larger movement on the TVD Scale. 
The Opacity field ranges from 1 (solid) to 0 (clear). 

An Example of the Zones displayed in the User Defined view shown below. 
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Surface Coordinates Tab (Properties Window) 

 

This portion of the window allows the user to add the Latitude (Lat:) /Longitude (Long:) for the surface hole which is 
necessary if this is an additional well to be plotted or correct the DLS or NTS portion of the window. These fields were 
entered when the survey plot was initially started. 
The surface hole Longitude and Latitude fields to not have to be filled in if this is the first well to plot in the survey 
view application. Any subsequent well data to be displayed the user must fill in the surface hole well co-ordinates for 
both Latitude and Longitude in degrees minutes and seconds and we will utilize these fields to get subsequent well 
data onto the plot. If you enable the check box beside the DLS your Plan view and User-defined view will have the 
DLS grid system marked. The DLS Survey breakdown would be as follows for this example location 
09-26-001-28 W1M. Where the 09 is the Location, 26 is the Section, 001 is the township and 28 is the range and the 
1 is the meridian 

The Meters North of the South Boundary must be just that. If your survey 
plat gives you from the north boundary, then you have to subtract that 
number from 1,609.34 m to give you the meters North of South Boundary. 
The Meters East of the West Boundary must be just that. If your survey 
plat gives you from the east boundary, then you have to subtract that 
number from 1,609.34 m to give you the meters East of West Boundary. 
The Road Allowance field (these are dead areas in the DLS grid system) 
is traditionally the default value (20.12) but can in some places (30.18). 
The Township field (Values from 1 to 126) depends on the well location. It 
is necessary because we have to accommodate for correction lines if 
your well crosses those on the plan or user defined views. The Section 
field (Values 1-36) depends on the well location. It is necessary because 
we have to accommodate for road allowances if your well crosses those 
on the plan or user defined views 

7. Click on the  button. If done correctly and you have sufficient surveys you should get the survey window 
filled in with the four (4) views of your well bore. You should see something similar to one of the Survey window 
shown above. 
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NTS Example 

 
If you enable the check box beside the NTS your Plan view and User-defined view will have the NTS grid system 
marked. 

To the left is an example of the NTS survey system location. Remember we are 
dealing with the surface location. 
a-18-D 94-A-13 whereas a is the ¼ Unit, 18 is the Unit, D is the block, 94 is the 
series, A is the Area and 13 is the sheet. 
Fill in the surface location fields from the surface location given to you in the 
survey plat. In this NTS system we can use any corner for the measurements 
on the surface location but you must pick one from the drop box Then fill in the 
Meters from the North / South Boundary. Then fill in the Meters from the East / 
West Boundary. If you are adding multiple wells then you must also fill the 
surface hole Longitude and Latitude fields to not have to be filled in if this is the 
first well to plot in the survey view application. Any subsequent well data to be 
displayed the user must fill in the surface hole well co-ordinates for both 
Latitude and Longitude in degrees minutes and seconds and we will utilize 

these fields to get subsequent well data onto the plot. 

4. Click on the  button. If done correctly and you have sufficient surveys you should get the survey window 
filled in with the four (4) views of your well bore. You should see something similar to one of the Survey window 
shown above. 

Power*Steer Module 
Connecting to the Database 

1.) Double click on the Power*Steer  Icon. This will initiate the program and activate a Connect Database 
window. 

 
1.) Highlight the PGEOLOGY 2016 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it once. 
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2.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field. 
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field. 

3.) Type “pgeology” in the Password field and then click on the  button. The program will now load 
various dictionaries and then activate a Well List window. 

 
4.) Double Click on the Well you want to open or Highlight the Well and then click on the  button. If 

this is the first time the Well has been opened it will be a blank template starting at zero depths with no scales. 

File Menu 
The File pull down menu contains numerous selections described below. 

Open Selection 
1. Click on the File Menu to activate the drop down list and click on the Open Selection to activate the 

Choose Well List. 

          

2. Select the well you wish to work with in Power*Steer by double clicking on the well name or highlighting 

once and click on the  button. 
Note: The Recently Used list (located above the Well List) will remember the last 10 wells you worked on. 

Close Selection 
1. Click on the File Menu to activate the drop down list and Click on the Close Selection to close the well you 

have open in Power*Steer. 
Refresh Data Selection 

1. Click on the File Menu to activate the drop down list and Click on the Refresh Data Selection to refresh the 
well’s data you have open in Power*Steer. 
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This would be done if you have updated the data in Power*Log or Power*Curve and the well is already open in 
Power*Steer. Otherwise if you have just opened the well then there is no need to refresh the data. 

Background Graphic Add Selection 
The User has the ability to place a graphic (maybe a seismic representation in the background of the Power*Steer 
Well Path Pane 

1. Click on the File Menu to activate the drop down list and Click on the Background Graphic Selection. This 
will activate a Pop out menu. 

2. Click on the Add selection. You will be prompted with an Open Picture File window. 

   

3. Navigate the folder and file name and then Click on the  button. This will open a Set Background 
Image window. 

4. Type in the appropriate True Vertical Depth (TVD) top and base depths along with the appropriate Vertical 
Section (VS) depths tabbing between fields. 

5. Click on the  button. You should see your graphic displayed at the appropriate depths. 
Background Graphic Remove Selection 
The User has the ability to remove a graphic once it has been added. 

1. Click on the File Menu to activate the drop down list and Click on the 
Background Graphic Selection. This will activate a Pop out menu. 

2. Click on the Remove selection. The graphic previously inserted will be 
removed. 

Import Selection 
1. Click on the File Menu to activate the drop down list and Click on the 

Import Selection. This will activate a pop out list. 
2. Click on the Import Log / Well selection to import Power*Suite data 

exported from another user or time into Power*Steer. This will activate the 
Power*Log Data Transfer Import window. 

Importing a Log / Well… 

1. Click on the  button to browse through your 
drives/directories for the file(s) you wish to import. Note that 
files available for importing will have an .EXP file extension. 
Any of the files that you select will then be added to the File 
list. Please make sure that the files you wish to import are 
highlighted (selected), in the list prior to importing. 

Note: The button will remove the selected/highlighted files 

from the import list, but will not delete them. The button, 
on the other hand, will completely erase the selected/highlighted files 
from their directory. Once deleted, these files will no longer be 
recoverable. 

2. Click on the button to activate the following 
system message, “Do you really want to IMPORT the 
highlighted files?” 

3. Click on the  button to proceed with the import. 
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Note: If you click on the  button, and the file you are importing contains the information from an Entire Well, 
the following system message will be activated, “About to IMPORT ENTIRE WELL data. All information 
associated with this well in the database will be OVERWRITTEN. Continue?” 

4. Click on the  button. Upon completion of the import, the following system message will then be 
activated, “Data has been imported successfully.” 

5. Click on the  button to confirm the successful import of the data. 
6. Once the data has been imported you must select Refresh data from the File pull down menu. 

Export Log / Well 
Allows you to export log configurations, well information, system 
symbols and your Geology Expansion Dictionary. In this example we 
will show you how to export your Power*Steer data only. 

1. Click on the File Menu to activate the drop down list and select 
Export. This will activate a pop out menu 

2. Select Export Log / Well from the pop out menu. This will activate 
the Power*Log Data Transfer Export Window 

When Data Transfer Export window opens from the main Power*Log / 
Core, Curve and Steer™ it automatically defaults to the currently active 
Power*Steer log. 

 
3. The Log Configuration check box  should not be activated (unchecked), as you are not exporting a log. 
4. The Entire Well check box  should also be activated (unchecked), as it is the default but in our case we 

will uncheck the Entire well as we are just exporting the Power*Steer data. 

5. Because we are exporting only the Power*Steer data click on the  buttons beside the Interval and 
Record Based Data. This will deselect all the Interval and record based data types. 

Record Based Data: 

6. In the Record based Data portion of the window and click on or select the Power*Steer data selection to 
highlight it. 

7. Name the export file by clicking on the  button and then select a destination and a filename. Do 
not type in a file extension other than .EXP. If you omit the extension, an .EXP file extension will be added, 
automatically, to your filename by Power* Steer™. 

8. Click on the  button. 
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This will backup your Power*Steer data that can be imported if things go awry or is overwritten by another 
export file. 
Export Segment Data 
This utility exports your Power*Steer Segment data into a *csv (comma separated values) file format which can then 
be utilized by other applications. 

1. Click on the File Menu to activate the drop down list and select Export. This will activate a pop out menu 
2. Select Segments from the pop out menu. This will activate a Segment Export File Name window. 

      

3. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click 

on the  button. This will activate the Segment Export File Created window. 

 

4. Click on the  button to exit Segment Export file window. 
This will export the segment data only which can then be utilized by another 3rd party application. We cannot import 
this segment file data. 
Export Surface or Zone Data 
This utility exports your Power*Steer Surface data into a *csv (comma separated values) file format which can then 
be utilized by other applications. 

1. Click on the File Menu to activate the drop down list and select Export. This will activate a pop out menu 
2. Select Surfaces from the pop out menu. This will activate a Surface Export File Name window. 
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3. You will have to choose a zone of formation top to export from the drop list provided. 

 
4. Decide on the X and Y coordinate system. We can export the data in either Longitude / Latitude or UTM Co-

ordinates. Click on the radial button to determine which system to use. 

 
5. These surface co-ordinates are originally taken from the Well Record for the well. If the choice is Long / Lat 

and you have nothing in the well record for the Surface co-ordinates and you have the co-ordinates in 

degrees minutes second format you will want to click on the  button to activate the Longitude and 
Latitude DMS entry window. 

 

6. Click on the  check box and type in the appropriate data. Click on the  button to close 
the window and this action will fill in the Long / Lat portion of the window. 

7. Determine whether you want the Z portion (depth) of the export file in subsea or true vertical depth values by 
checking the check box for Subsea. 

 
8. Determine the depth increment of the file to be exported (along the Target Azimuth of the well) by typing in 

a number in the increment field. The default is 50 meters. 

 

9. Click on the  button. This will activate the Specify Export File Name window. 
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10. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click 

on the  button. This will activate the Segment Export File Created window. 

 

11. Click on the  button to exit Export file window. 
This will export a single surface in the desired format so that it can then be utilized by 
another 3rd party application. We cannot import this Surface file data. 
Print 

1. Click on the File Menu to activate the drop down list. 

2. Click on Print selection or click on the  Print button on the Toolbar to 
activate the Print Options window shown below. 

3. VS / MD Range portion of the window indicates the Vertical Section depth range or 
Measured Depth Range you wish to print. Type in the depth range in the fields 
provided. 
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(Your Power*Steer application may be in Measured Depth [MD Range] units.) 
4. Well Path Scale portion of the window indicates the TVD depth range you wish to print. Type in the TVD 

depth range in the fields provided. 
5. Type Well Width field is how wide you want to print this 

portion of the Power*Steer window. Type in a width in 
Inches in the field. 

The depth scale interval and scale of the Type well will be 
determined by what is viewed on your screen and the paper 
size an orientation. 

6. Border field is how much border you wish to have 
around the top, bottom, and left edges of your print. 
Type in a border width in inches in the field. 

7. Print field drop box is the VS Depth Scale of your print. 
Click on the drop box and select from the List or the 
user can also Type a VS depth scale in the field. 

8. Click on the Service Company logo  button to 
search your computer for a logo to put in your header. 

9. Type in the Type well Name / Location is the Type Well field. Depress the tab key on your keypad to 
advance the cursor to the Interpreter field. 

10. Type in the Interpreters name who created the interpretation in the Interpreter field. 

 button allows the user to setup the printer for the Power*Steer output 

11. When you are ready to print your Power*Steer log, click on the  button. 

Edit Menu 
Redo 
This selection allows the user to redo and undo of the last segment revisions. This can go on for 
as many undo’s that have been made by the user. It is only applicable to the segment revision. If 
a user deletes other data they will have to enter that data again. The undo comments changes 
with each function performed to indicate what undo action will be performed. 

1. Click on the File Menu to activate the drop down list and select Redo. 
2. Perform this action as many times as is necessary. 

Note: Commonly it will take a couple of redo’s to get back to where you were. 

Undo 
This selection allows the user to undo the last segment revisions. This can go on for as many 
undo’s that have been made by the user. It is only applicable to the segment revision. If a user 
deletes other data they will have to enter that data again. The undo comments changes with 
each function performed to indicate what undo action will be performed. 

1. Click on the File Menu to activate the drop down list and select Undo. 
2. Perform this action as many times as is necessary. 

Note: Commonly it will take a couple of undo’s to get back to where you were. 

Calculate In / Out 
This menu selection works with the zones that were added and where the 
zones were indicated as the top and base. When those are defined the user 
can select this Edit menu selection and it will calculate the amount of well path 
that is in the zone and the amount of well path that is out of the zone. This 
calculation is started when the well path first encounters the top of your zone 
of interest. 

1. Click on the Edit Menu to activate the drop down 
list and select Calculate In / Out. 

This will be printed in the output as well as displayed in 
the Status bar when your mouse pointer is focused in the Well Path portion of the window. 
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View Menu 
Measured Depth View 

1. Click on the View Menu to activate the drop down list. 
2. Click on Measured Depth View to switch from Measured Depth view to 

Vertical Section Depth view and vice versa. 

Note: Sometimes in the beginning before the well gets to a continuous positive Vertical Section Segments cannot be 
added because of the fact that the well is going back and forth on itself with respect to Vertical Section and can only 
be added in the Measured depth view. 

Toolbar 
1. Click on the View Menu to activate the drop down list. 

2. Click Tool bar selection to turn on or off the toolbar.  

The toolbar buttons will allow you to Open another well, Undo, Redo, access the about menu and activate the Print 
the Power*Steer Log. 
Note: To activate the Help Menu depress the F1 key on your keypad 

Status Bar 
1. Click on the View Menu to activate the drop down list. 
2. Click on Status Bar selection to turn on or off the Status Bar. 

 Mouse pointer in MD Gamma Ray portion of window. 

 Mouse pointer in Well Path portion of window. 

 Mouse pointer in Type Well portion of window. 

Go To Depth (Type Well) 
1. Click on the Type Well Portion of the window. 
2. Click on the View Menu to activate the drop down list. 
3. Click on Go To Depth (Type Well) selection to activate the Goto Window. 
4. Type a depth in the Type Well Depth Field. 

5. Click on the  button. 

Go To Depth (Well Path)  
1. Click on the Well Path Portion of the window. 
2. Click on the View Menu to activate the drop down list. 
3. Click on Go To Depth (Well Path) selection to activate the Goto Window. 
4. Type a depth in the Well Path Depth Field. 

5. Click on the  button. 

Type Well Track Depth Scrolling 
Once the Type Well curve has been added to this track the user has the ability to scroll up and down the curve depth 
display. 
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Mouse Pointer Controls 
The user can click on the up / down arrows on the right side of the track pane 
to move up or down a bit or click on the space between the thumb and 
arrows to move up or down 1/4 page. 

Mouse Roller Ball Control 
Click on the Type Well pane and then roll the roller ball away from you to 
scroll up the view. 
Click on the Type Well pane and then roll the roller ball towards you to scroll 
down the view. 

Type Well Depth Scale Display Manipulation 
Click on the Type Well pane, hold the CTRL Key down on the keypad and 
then roll the roller ball away from you to decrease the scale so that you can 
see less data in the Type Well. 
Click on the Type Well pane, hold the CTRL Key down on the keypad and 
then roll the roller ball towards you to increase the scale so that you can see 
more data in the Type Well. 
 
 
 
 
 

Type Well Pane Right Click Options 
Set Type Well Curve 

1. Right click on the Type Well portion of the screen (left side) 
2. Select Set Type Well Curve from the pop out menu list. This will activate a Select Curve list. 

         
3. Select the Type Well GR Curve you are steering to. This is Type Well GR curve you imported into your 

steered well in Power*Log or Power*Curve. 
4. Click on the  button. 

Mapped Offset 
This allows the user to offset or shift the MD Gamma Ray Curve data that has been mapped onto the type well curve 
to the left with a negative number and to the right with a positive number. 

1. Right click on the Type Well portion of the screen (left side) 
2. Select Mapped Offset from the pop out menu list. This will activate the Mapped Curve Offset window. 

 
3. Type in a value (+ moves right / - move left) in the field provided. 
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4. Click on the  button. 

 

Add Segment 
Once the reference point has been set you will see a pink line in both the Type Well and your 
Steering well. You can now add segments. A segment is usually defined over an interval where 
the MD / VS Gamma curve can be correlated with the Type well curve and more than likely be 
a continuous downward or upward well path movement. 

Add the first Segment 
(First one is different than all the rest) The top of this segment cannot be moved. The rest of the 
segments after the first can be moved or resized. 

1. Right Click somewhere near (but deeper) than your reference point and Select Add Segment from the pop 
out menu list. 

Note: Once the first segment has been added you may not be allowed to add another segment due to the fact that 
you have a negative vertical section where you are adding the next segment. 

2. If you are experiencing the Segment Add Error message when you are adding another segment Click on 
the  button in the message box. 

     
3. Then switch your View from Vertical Section to Measured depth view by clicking on the View menu pull 

down and selecting Measured depth to switch from Vertical Section View to Measured Depth View. This 
will allow you to add another segment in either the Type Well or the Well Path panes. 

4. You will more than likely have to scroll deeper on the Well Path section to see you Gamma Ray / Well Path 
data. 

Set Reference Point 
First thing you have to do is set up a reference point. You will need to know the Regional strike and dip of the 
formation you wish to steer this well for and maybe a depth offset so that you can move the steered wells curve data 
up or down to match near the zone of interest. This offset can be changed after the fact but the Regional Strike and 
Dip will not be allowed to change. If you do want to change the Regional strike and dip then you will have to delete 
the Reference point and that will delete all the segments that have been entered so you will be starting anew. 

1. Right Click on the Type Well Pane a little above the depth that you wish to start your correlations and 
select Set Reference Point from the pop out menu list. This will activate the Reference Point window. 

       
2. In the Reference Point window the user will fill in the general bed dip degree and strike azimuth for your 

intended formation or zone you wish to steer. Tab to the Dip field or double click to highlight the Dip field, 
Type the dip for the bed in the dip field, depress the tab key to advance the highlight to the azimuth field. 

3. Type in the strike azimuth of the bed in this field. Depress the tab key to advance the highlight to the 
Type Well Offset field. 
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4. Type in the Type well offset. This is not too critical as this can be changed after the fact. It just moves your 
correlatable well up or down to match with the Type well. 

Note: A negative number will shove the Gamma Ray trace up and a positive number will shove your Gamma Ray 
trace well down. 

5. Click on the  button. 

Edit Reference Offset 
The Reference offset results in moving the traces from the VS / MD gamma segments shown on the Type Well up or 
down with respect to the Type Well Gamma Curve. A negative number (-5) will move the traces up 5 in the Type Well 
where a positive number (5) will move the traces down 5 in the Type Well. 

1. Right Click on the Type Well Pane at the depth where your Reference Point is set (indicated by a Pink 
Line with Reference Point Text below it) and select Edit Reference Offset from the pop out menu list. This 
will activate the Reference Point window. 

        
2. The user can then only change the Type Well Offset. Type in a new Type Well Offset (TVD) in the field 

provided and click on the  button. 

Note: If you need to change the Regional Bedding Dip and Azimuth then you will have to Delete the Reference Point 
and start again removing all your segment data. 

Delete Reference Point 
1. Right Click on the Type Well Pane at the depth where your Reference Point is set (indicated by a Pink 

Line with Reference Point Text below it). 
2. Select Delete Reference Point from the resulting pop out menu. This will activate the Warning Message. 

            
3. Click on the  Button. 

Note: If you need to change the Regional Bedding Dip and Azimuth then you will have to Delete the Reference Point 
and start again removing all your segment data. 

Add Zone 
This would be where you would add a Zone to your Type Well. They could be formation tops or other indicators that 
you wish to mark on your Type Well and will be transposed and manipulated by your segment movements in the Well 
Path pane. 

1. Right Click at the depth you wish to add a Zone in your Type Well pane to activate the pop out menu. 
2. Select Add Zone from the pop out menu list. This will activate the Add Label window. 
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3. Type in a Zone / Label Name in the field provided. 

Note: If this is a zone marker that indicates that you are inside the designated target and you would like to 
calculate the percentage of the well’s path that is inside the target boundaries then you must indicate whether 
this label is the top or base of the Zone. The user can only have one labels designated at top and one zone 
label that is designated as base. 
4. If this is the primary target label indicator then you must activate a radio button indicating the top or base 

by clicking on the radio button. . If it is not the designated target zone label then skip on to 
step 5. 

5. If this is a zone marker that indicates that you are inside the designated target and you would like to 
calculate the percentage 

6. Click on the  button. This will close the window and add the zone label to both the Type Well and 
Well Path panes. 

This will add the zone to both the Type Well and the Well Path Panes You may not see the 
zones on the Well Path Pane until you have some segments added. 

Delete Zone 
1. Right Click on the Type Well Pane at the depth where the Zone Label has been 

added. 
2.  Select Delete Zone from the pop out menu list. This will delete the Zone label from 

both the Type Well and the Well Path Panes. 

Show All 
This selection is more like a toggle to show all / hide all the segment traces that have been 
added and manipulated on the type well. The first time will show all and then the next time will 
hide all the segment data. 

1. Right Click anywhere in the Type Well Pane 
2. Select Show All from the pop out menu list. 

Note: If you click on a segment in the lower portion of the Well path (under the Curve trace portion of the window 
(Indicated by a color bar) it will turn red to show that it is selected and then double click on the red bar and this will 
turn on the segment in the Type well Pane after selecting another segment and will be indicated by the default color. 

General Properties 
Curve Display Properties 

1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
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 Right Click Type Well Pane Right Click Well path Pane 

1. Click on the drop arrow and select the curve you wish to change the display for. 

 
2. Line Size portion of the window will change the line thickness from 1 to 20 (pixels wide). You have to type 

a number in the size field and your input will be automatically displayed by the curve. 
3. Line Style portion of the window will change the line style. You have to type a number in the style field 

from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line, 1=Dashed Line, 
2=Dotted Line, 3=Dash Dot Line 

4. Scale Portion of window allows the user to change scales for the selected curve. Type a value in the 
appropriate fields to change the scales. The scales will change as you type. 

5. Grid Portion of window allows the user to change the grid pattern for the selected curve. Type a value in 
the appropriate fields to change the grids. The grids will change as you type. Major Grids will indicate a 
value. The minor grids will divide the whole track and not the majors. 

6. Ignore NULL’s check box when activated will join curve values ignoring the null values. When deactivated 
the curve will only draw when there are two consecutive data points. 

7. Click on the  in the upper right hand corner to exit this window. 

Formation Display Properties 
1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
3. Click on the Formations Tab to activate the Formation display properties. 

Note: Formations will only appear in this list if they have a calculated thickness in the Formation Report window in 
Power*Log, Power*Core or Power*Curve. 
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4. Activate the check box beside the formation you wish to display in the Well Path portion of Geo*Steer. 

5. If the formation is highlighted the user can also select a color from a color palette activated by the  
button. Click on a color and then click on the  button. 

6. Click on the  in the upper right hand corner to exit this window. 

Zones Display Properties 
1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
3. Click on the Zones Tab to activate the Zones display properties. 

Note: Zones will only appear in this list if they been entered in the Type Well Portion (left side) of the Geo*Steer 
application. 

1. Click on the drop arrow and select the zone you wish to change the display for. 

Note: You can change the display name if you wish by typing in a new Zone name. These can be tops or any other 
indicators you wish to display in the Well Path Section of the Geo*Steer application. 

 
2. Line Size portion of the window will change the line thickness from 1 to 9 (pixels wide). You have to type 

a number in the size field and your input will be automatically displayed by the curve. 
3. Line Style portion of the window will change the line style. You have to type a number in the style field 

from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line, 1=Dashed Line, 
2=Dotted Line, 3=Dash Dot Line 

4. Click on the  in the upper right hand corner to exit this window. 

Screen format Properties 
1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
3. Click on the Screen Format Tab to activate the Screen format display properties. 
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4. Double Click in the Well Path Track field and change the % from 70 to another percentage to change the 
Well Path Pane size. 
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Well Path MD/VS Gamma Ray Depth Scale Display Manipulation 
1. Click on the Well Path pane, hold the CTRL Key down on the keypad and then roll the roller ball away 

from you to decrease the scale so that you can see less data in the Well Path and MD / VS Gamma Ray. 

1. Click on the Well Path pane, hold the CTRL Key down on the keypad and then roll the roller ball 
towards you to increase the scale so that you can see more data in the Well Path and MD / VS Gamma 
Ray. 

 

Well Path TVD Scale manipulation 

Mouse Pointer Controls 
1. The user can click on the up / down arrows on the right side of the track pane to move up or down a bit or 

click on the space between the thumb and arrows to move up or down 1/4 page. This will move all the 
scales (both top and bottom scales simultaneously). 

Mouse Roller Ball Control 
1. Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball 

towards you will move the TVD scale down (both top and bottom scales simultaneously). 

2. Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball away 
from you will move the TVD scale up (both top and bottom scales simultaneously). 

3. Click and drag up on the Well Path portion of the pane to see a more detailed view or less TVD range. This 
action will not move the bottom TVD scale. 

4. Click and drag down on the Well Path portion of the pane to see a less detailed view or more TVD range. 
This action will not move the bottom TVD scale. 

Well Path MD/VS Gamma Ray Depth Manipulation 
Once the Well Path TVD curve, Measured Depth Gamma Ray curve has been added to these track the user has the 
ability to scroll left and right to change the curve depth display. 
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Mouse Pointer Controls 
1. The user can click on the left / right arrows on the bottom side of the track pane to move left or right a bit 

or click on the space between the thumb and arrows to go left or right 1/4 page. 

Mouse Roller Ball Control 
1. Click on the Well Path pane and then roll the roller ball away from you to scroll left or back. 

2. Click on the Well Path pane and then roll the roller ball towards you to scroll 
right or forward. 

Well Path Pane Right Click Options 
Add Segment 
Right Click on the Well Path Pane at the depth you wish to add a segment and select 
Add Segment from the resulting pop out menu. This will add a segment at that depth. 
Note: Segments can be added anywhere but you will want to add segments where the 
well path changes from up to down (< 90 / > 90) or where the segments start to vary from 
your Type well trace. 

Delete Segment 
In the Well Path Pane click on the Segment you wish to delete. Anywhere between the 
segment depths to change the color of the segment from it’s default color to a red 
indicator to make it active. 
Right Click anywhere between the Segment depths on the Well Path Pane and select 
Delete Segment from the resulting pop out menu. This will delete the segment. 

Change Azimuth 
In the Well Path Pane click on the Segment you wish to change Azimuth or bed Strike. 
Anywhere between the segment depths to change the color of the segment from it’s 
default color to a red indicator to make it active. 

1. Right Click anywhere between the Segment depths on the Well Path Pane to 
activate the pop out menu. 

2.  Select Change Azimuth. This will activate the Change Azimuth window. 

         
3. Click on the up or down arrows to change the segments strike azimuth. Once you have the corrected 

azimuth viewed. 

4. Click on the  button. 

Note: Changing the segment azimuth will affect the apparent dip and will result in a change of VS Start and VS End 
points. Once this new segment azimuth has been changed it will change the apparent dip for all segments added 
after this change. 

Set Well Path 
1. Right click on the Well Path pane (right side) to activate the pop out menu 
2. Select Set Well Path. This will activate a Select Curve Window. 
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3. Select the steered Well Path Curve in TVD units from the drop down list by clicking on the down arrow 

and selecting it from your curve list for this well from your database. 
4. Click on the  button. 

Note: This curve has to be added on the setup of Power*Log / Power*Curve when the well is started. If this has not 
been done then you will not see this curve available to you. The Well Path (TVD) curve can be imported into 
Power*Log / Power*Curve from an LAS or ASCII file or can be calculated with the survey data. 

Set Gamma 
1. Right click on the Well Path pane (right side) to activate the pop out menu 
2. Select Set Gamma. This will activate a Select Curve Window. 

               
3. Select the steered wells Gamma Ray curve in measured depth units from the drop down list by clicking on 

the down arrow and selecting it from your curve list for this well from your database. 

Note: This Gamma Ray curve will be displayed on the lower portion of the well path and will either be displayed in 
MD or VS depth units depending on the view. This is the curve that you will be attempting to correlate to the Type 
Well Curve. It doesn’t necessarily have to be the Gamma Curve but this tool is by far the most common tools to be 
run downhole while drilling. 

4. Click on the  button. 

Note: This curve has to be added on the setup of Power*Log / Power*Curve when the well is started. If this has not 
been done then you will not see this curve available to you. The Gamma Ray curve can be imported into Power*Log / 
Power*Curve from an LAS or ASCII file.  

Overlay Curves 
If the user wishes to have more curves displayed on the Segment portion of the window the user can also display 
those curves in either MD or vertical section depth display. These are only for display purposes and will not be used 
to correlate to the Type Wells data. 

1. Right click on the Well Path pane (right side) to activate the pop out menu 
2. Select Overlay Curves. This will activate an Overlay Curves list. 
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3. Select as many of the other curves captured in your wells database. Display these curves data by activating 

the check box beside the curves. 

Note: These Overlay curves will be displayed on the lower portion of the well path and will either be displayed in MD 
or VS depth units depending on the view. These curves are for display purposes only. 

4. Click on the  button. 

Note: These curves have to be added on the setup of Power*Log / Power*Curve when the well is started. If this has 
not been done then you will not see these curves available to you. 

Segment Properties 
This selection allows the user to view the segment properties on each induvial segment. They include Measured 
Depths from and to, Vertical Section Depths from and to, True Vertical Depths from and to, segment dip and azimuth, 
segment throw, segment default color and display option on the Type Well Pane. 
In the Well Path Pane click on the Segment you wish to view the properties of. Anywhere between the segment 
depths to change the color of the segment from it’s default color to a red indicator to make it active. 

1. Right Click anywhere between the Segment depths on the Well Path Pane to activate the pop out menu. 
2. Select Segment Properties. This will activate the Segments window. 

           

3. Click on the  to close this window. 

Note: This is the information that is exported when you Export Segments. You may wish to keep this window open to 
compare the strike and dips of the segments. Also if you see the throw field has a value (other than 0.00) displayed 
and you have not placed a fault on purpose then you do have an issue. The throw is carried forward from segment to 
segment. So you will have to find the first segment that changed from 0.00 throw to a throw value and attempt to 
make the throw back to 0.00 by moving the segment up or down on the Type Well pane. 

General Properties 
Curve Display Properties 

1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
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 Right Click Type Well Pane Right Click Well Path Pane 

3. Click on the drop arrow and select the curve you wish to change the display for. 

 
4. Line Size portion of the window will change the line thickness from 1 to 20 (pixels wide). You have to type 

a number in the size field and your input will be automatically displayed by the curve. 
5. Line Style portion of the window will change the line style. You have to type a number in the style field 

from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line, 1=Dashed Line, 
2=Dotted Line, 3=Dash Dot Line 

6. Scale Portion of window allows the user to change scales for the selected curve. Type a value in the 
appropriate fields to change the scales. The scales will change as you type. 

7. Grid Portion of window allows the user to change the grid pattern for the selected curve. Type a value in 
the appropriate fields to change the grids. The grids will change as you type. Major Grids will indicate a 
value. The minor grids will divide the whole track and not the majors. 

8. Ignore NULL’s check box when activated will join curve values ignoring the null values. When deactivated 
the curve will only draw when there are two consecutive data points. 

9. Click on the  in the upper right hand corner to exit this window. 

Formation Display Properties 
1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
3. Click on the Formations Tab to activate the Formation display properties. 

Note: Formations will only appear in this list if they have a calculated thickness in the Formation Report window. 
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4. Activate the check box beside the formation you wish to display in the Well Path portion of Geo*Steer. 

5. If the formation is highlighted the user can also select a color from a color palette activated by the  
button. Click on a color and then click on the  button. 

6. Click on the  in the upper right hand corner to exit this window. 

Zones Display Properties 
1. Right Click anywhere in either pane to activate the pop out menu. 
2. Select General Properties. This will activate the General Properties window. 
3. Click on the Zones Tab to activate the Zones display properties. 

Note: Zones will only appear in this list if they been entered in the Type Well Portion (left side) of the Geo*Steer 
application. 

4. Click on the drop arrow and select the zone you wish to change the display for. 

You can change the display name if you wish by typing in a new Zone name. These can be tops or any other 
indicators you wish to display in the Well Path Section of the Geo*Steer application. 
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5. Line Size portion of the window will change the line thickness from 1 to 9 (pixels wide). You have to type 
a number in the size field and your input will be automatically displayed by the curve. 

6. Line Style portion of the window will change the line style. You have to type a number in the style field 
from 0 to 3 and your input will be automatically displayed by the curve. 
0=Solid line, 1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line 

7. Click on the  in the upper right hand corner to exit this window. 

Show / Hide Formation Top Names 
This selection is a toggle to either Show or Hide the Formation Top Names displayed on 
the Well Path pane. 

1. Right click on the Well Path pane (right side) to activate the pop out menu. 
2. Select Show / Hide Tops from the pop out menu list. This will toggle between 

Showing and Hiding the Formation Top Names in the Well Path pane 

Show / Hide Zone Names 
This selection is a toggle to either Show or Hide the Zone Names displayed on the Well 
Path pane. 
1. Right click on the Well Path pane (right side) to 
activate the pop out menu. 
2. Select Show / Hide Zones from the pop out menu 
list. This will toggle between Showing and Hiding the Zone 
Names in the Well Path pane. 

 

 

 

Show / Hide Perforations 
This selection is a toggle to either Show or Hide the Perforated Intervals entered into 
Power*Suite displayed along the Well Path curve in the Well Path pane. 
Note: The perforated intervals must be either imported or created in Power*Log, Core or Curve. 

1. Right click on the Well Path pane (right side) to activate the pop out menu. 
2. Select Show / Hide Perforations from the pop out menu list. This will toggle between Showing and Hiding 

the Perforated Intervals along the Well Path curve in the Well Path pane. 

     
 Perforated Intervals Shown Perforated Intervals Hidden 
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Show / Hide Zone Fill 
This selection is a toggle to either Show or Hide the Zone Fills displayed on both the 
Well Path and Type Well Panes. The Zone fill will fill in the area between the Zone 
Marker and the next Zone Marker. 

1. Right click on the Well Path pane (right side) to activate the pop out menu. 
2. Select Show / Hide Zone Fill from the pop out menu list. This will toggle 

between Showing and Hiding the Zone Fills on both the Well Path and Type 
Well Panes. 

 
Hidden Zone Fills above / Shown Zone Fills below 

 
The Colors of the fill are determined by the Zone Markers Colors found in the Right Click General properties 
selection located in the Zones Tab 

Segments 
This is the nuts and bolts of the Power*Steer application and we should spend some time explaining what a segment 
does for you. Before we can add a segment we must add a Reference point to tie the Segment data to the Type well. 
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A segment consists of various integral pieces of data that has Vertical Section depths from and to, Measured Depths 
from and to, True Vertical Depths from and to along with Dip angle, Azimuths and throws. All the Segment data is 
manipulated on the type well by shrinking and extending the VS start and VS end points, moving the entire segment 
to create a throw (indicated by a fault on the Well Path Pane) or changing the Segment Azimuth. So we will start with 
setting a Reference Point. 
Before any of this is done you will have to add the Type Well Gamma Ray Curve (TVD units), the steered well 
Gamma Ray curve (MD units) and the Well Path curve (TVD Units). 

Set Reference Point 
First thing you have to do is set up a reference point. You will need to know the general strike and dip of the formation 
you wish to steer this well for and maybe a depth offset so that you can move the steered wells curve data up or 
down to match near the zone of interest. This offset can be changed after the fact but the Strike and Dip will not be 
allowed to change. If you do want to change the strike and dip then you will have to delete the Reference point and 
that will delete all the segments that have been entered so you will be starting anew. 
Right Click on the Type Well Pane a little above the depth that you wish to start your correlations and select Set 
Reference Point from the pop out menu. This will activate the Reference Point window. 

       
In the Reference Point window the user will fill in the general bed dip degree and strike azimuth for your intended 
formation or zone you wish to steer. 
Tab to the Dip field or double click to highlight the Dip field, Type the dip for the bed in the dip field, depress the 
tab key to advance the highlight to the azimuth field, type in the strike azimuth of the bed in this field, depress the 
tab key to advance the highlight to the Type Well Offset field and type in the Type well offset. 
Type Well Offset field is not too critical as this can be changed after the fact. It just moves your correlatable well up 
or down to match with the Type well. A negative number will shove your steered well being drilled up and a positive 
number will shove your correlatable well down. 
Click on the  button. 

 
Once the reference point has been set you will see a pink line in both the Type Well and your correlating well as 
shown above. You can also see a zone marker (Nisku Shale 6-7) in the illustration above. We will deal with the zone 
markers later on in the manual. 
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Add the first Segment  
(First one is different than all the rest) The top of this segment cannot be moved. It is just a 
starting point. The rest of the segments after the first can be moved or resized. 

1. Right Click somewhere near (but deeper than) your reference point and Select 
Add Segment from the pop out menu. 

The first segment will be displayed on your Type Well as a red curve and will be placed at 
the offset depth that was entered into your Set Reference Point. The display depths on the 
Type Well pane have been recalculated into True Vertical Depth units so the user can 
attempt to correlate to the type Well. The first segment will extend to the end depth of your 
current data in your Gamma Curve. 
Note: You can only manipulate the bottom of this first segment (VS End). 

Adding a second Segment. 
1. Right Click somewhere near (but deeper than) than the Start of your first segment and Select Add 

Segment from the pop out menu. This can be done on either the Well Path pane or the Type Well pane 

The second segment will be displayed on your Type Well as a red curve and will also be placed at the offset depth 
that was entered into your Set Reference Point. The display depths on the Type Well pane have been recalculated 
into True Vertical Depth units so the user can attempt to correlate the second segment to the type Well. The second 
segment will extend to the end depth of your current data in your Gamma Curve. 

Note: This second segment may not be allowed due to the fact that you have a negative vertical section where you 
are adding the next segment. 

         
If you are experiencing this Error message when you are adding another segment. 

1. Click on the  button in the Segment Add Error window. 
2. Then switch your View from Vertical Section to Measured depth by clicking on the 

View menu pull down and selecting Measured depth to switch the view. This will 
allow you to add another segment in either the Type well or the Well Path panes.  

You will more than likely have to scroll deeper on the Well Path section to see you Gamma 
Ray / Well Path data. 

Defining a Segment 
A segment is a depth range on the Gamma Ray trace (either MD or VS depth range) that is 
then converted to TVD depth on the Trace Well. You have to click on the segment marker 
which is shown below the Steered well Gamma ray curve (turns red) to make it active on the 
Type well. Once it is active on the Type Well the segment will have a VS start line and VS finish line. The Gamma ray 
trace may go down or up or both depending on the well path over the segment interval. The segment trace on the 
Type well will appear red when going down and black when going up. 
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Changing the bedding angle of a Segment 
1. Click once on the Segment Marker below the Gamma Ray curve 

(shown above) to highlight the segment on the Type Well. 
2. If you were to move the mouse pointer to hover over the VS End marker 

(blue line above and right) or hover over the VS Start marker (mauve 

line above and right) the cursor will turn into a  
3. Click and drag the segment down (extend it) or drag it up (shrink it) to 

match the Type Well Gamma Curve. This result will be angle change for 
the Zone Markers and or Formation Tops if they are displayed on the 
Well Path. 

Changing the Strike Azimuth of a Segment. 
Changing the Strike Azimuth will change the apparent dip of the segment. 

1. Click once on the Segment Marker below the Gamma Ray curve 
(shown below) to highlight the segment on the Type Well. 

2. Right Click between the Segment Markers on the Well Path pane 
and select Change Azimuth from the resulting pop out menu. This will 
activate the Change Azimuth Window. 

       
3. Click on the up down arrows to change the Azimuth. 

4. Click on the  button. 

Segment Data Visibility on the Type Well 
If you would like to keep the Gamma Ray segment data on the Type well once you click on or create another 
segment. To view this data you would double click on the Segment portion under the Gamma Ray Curve. Vice 
versa it you want to turn it off you would then double click on the segment again. 
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Creating a fault 
1. Click once on the Segment Marker below the Gamma Ray curve (shown 

below) to highlight the segment on the Type Well. 
2. Move Mouse pointer between the VS End marker (blue line right) and the VS 

Start marker (mauve line) it will turn into a  
3. Click and drag the segment down or drag it up to match the Type Well 

Gamma Curve. This will result with a thrust or normal fault block for the Zone 
Markers and or Formation Tops if they are displayed on the Well Path.  

Extending or Decreasing the (MD / VS) size of a Segment 
As more data comes or you wish to extend or decrease the size of an existing segment. 
On the Type Well Pane 

1. Click once on the Segment Marker below the Gamma Ray curve (shown 
above) to highlight the segment on the Type Well. 

2. Click once on the Interval between the VS Start and VS End on the Type 
Well. 

3. Hold the Shift Key down on the keypad and then roll the roller ball on your mouse away from you to 
decrease the size of the Segment. You will notice the VS End going up on the Type Well Pane and to the 
left on the Well Path pane. Or Hold the Shift Key down on the keypad and then roll the roller ball on 
your mouse towards you to increase the size of the Segment. You will notice the VS End going down on 
the Type Well Pane and to the right on the Well Path pane. 

On the Well Path Pane 
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the segment 

on the Type Well. 

2. You can mouse over (Hover) on the Well path Pane over a Segment end line and it will turn into a  
and then you can click and drag left or right to increase or decrease the size of the segment. 
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Power*WITS Module 
The Wits Module allows the user to get the data hub, that is populated from the Electronic Drilling Recorder (EDR) in 
virtually real time. It allows you do download any and all curve data, survey data, and some of the well record data. 
The data populates the database and the user merely refreshes their log periodically. 
 
Connecting to the Database 

1.) Double click on the Power*WITS  Icon. This will initiate the program and activate a Connect 
Database window. 

 
2.) Highlight the PGEOLOGY 2016 METRIC (Microsoft Access Driver[*.mbd])) database by clicking on it once. 
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field. 

Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field. 

4.) Type “pgeology” in the Password field and then click on the  button. This will activate the 
Power*WITS window below. 
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Overview of Window 
These fields allow the user to type in the Network Sever name. The user will also have 
to fill in their User Id and password in the appropriate fields given to you by the Network 
Server administrator. 
 
 
This button will activate the connection to the server once you have identified the 
server and typed in both the User ID and the Password field. 
 
The Select Well portion of the window shows the wells that you have been given 
permissions to view and access data from. These permissions in this case are granted 
to you by a Network Server administrator or Pason representative. 
 
 
This field allows the user to determine how often the Power*WITS application will go 
and look for new data from the Server. If this is a Pason Server the data is updated to 
the server every 5 minutes so that would be the minimum time you would type in this 
field. 
 
This field notifies you of the last depth that curve data was retrieved from the server. If 
you are starting fresh you may want to type in the depth where you want to retrieve 
curve data from the server in this field. 

 
This field notifies you of the last depth that Survey data was retrieved from the server. If 
you are starting fresh you will want to type in the depth of Zero “0” where you will want 
to retrieve all the survey data from the server. 

 
This field allows the user to reset the Max Log/Curve Fetched back a few meters. The 
number you type in here will all depend on the depth of your hole or the positioning of 
the LWD tools in your bottom hole string. The bit depth when retrieved from the server 
will have some data but the Mud Gas Data / LWD data will be lagged. This field will  

 compensate for those depths so you have all the data. 
 

This portion of the Selection window allows the 
user to select different data types from the 
server. In this case we will be retrieving some 
well bore data including basic Striplog header 
information, survey data from trag3 in this case, 
and curve data from log-uid selection. The 
curves being retrieved are not being shown in 
the illustration to the left. The Survey data group 
will have a name made up from the server. Our 
default group name is 1 so you will have to 
modify the Master group to handle the import of 

 surveys from the server. 
 
This portion of the Selection window allows the 
user to select different curves to download from 
the server. In this case we will be retrieving 3 
sets of curve data from the Server. The curves 
being retrieved are Gam, PGAS and TOP.  
N.B. The curves being imported will have these 
curve names and must then be associated with a 
curve layer and will also have to have some 
scales associated with the curves for them to be 
displayed correctly. 
 

This button will use the save the selections of curve and well bore, that you have picked for data to 
download and will be saved with a file name that you provide.. 
This button will load the saved selection of curve and well bore selections that were saved from the Save 
Selection button. 

This button will start the download process with the particulars that you have entered into the various fields. 
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This button will stop the process and will only be seen after you start the download process. 
 

Connecting to the Server 
1.) Click in the Server name field and type in the sever name and website (in our case it is a Pason EDR) and the 

server location is “hub.pason.com”. Tab to the Userid field. 
2.) Type in your User ID in the Userid field. Tab to the Password field. 
3.) Type in your password in the password field. 

4.) Click on the button. 
Note: You will need some special permissions to access the datahub. 
 Drilling Bit Access (bit) 
 Drilling/Service Rig Data Access (edr) 
 Live Data (live_data) 
 And the be all end all you need permissions to the WITSML Server 
With these permissions you will be able to see the well names you have been given permissions to get data from. 

5.) Click on the Well Name in the Select Well portion of the Window. This will activate the Well in the lower portion 
of the window. 

 

6.) Click on the  to expand the well and activate the check mark in the appropriate box as indicated in the 
graphic below. 

 

7.) Click on the  to expand the wellbore-uid and activate the check mark in the appropriate box as indicated in 
the graphic below. 
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8.) Click on the  to expand the rig—uid (this will import some of the Well data but you may not want to keep this 
activated as it will overwrite the data you have put in the well record), trajectory—uid (this will import the survey 
data) and the log—uid (this will import the curve data) and activate the check marks in the appropriate box as 
indicated in the graphic below. 

 

9.) Click on the  to expand the log-uid and activate the check marks in the appropriate box as indicated in the 
graphic below for the curve data you wish to download. The Max Log / Curve Fetched field indicates the deepest 
data retrieved for your curve data to date. The Max Survey Data Fetch field indicates the deepest survey data 
fetched to date. 

 

10.) Click in the Update interval (min) field and type in a time interval you want the updating to happen in Minutes. 

11.) Click in the Data Lagged depth field and type in the depth delay or the lag you want to repeat when importing 
data. This is typically for gas as there is a lag from the time drilled to the time it is recorded on the surface. 
Otherwise you will be getting nothing but zeros for your gas. 

12.) Click on the  button. This will initiate the download of data. The curves downloaded will be in the 
database but will not be reflected on your log until you map the downloaded curve data to the appropriate layer. 
See Curve Maintenance section in the manual. 

13.) If you want to save the selected curve and well data click on the  button. This will initiate a 
Save WITS Setting File window. 
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14.) Type in a file name and click on the  button. 

15.) If you happen to close the Power*WITS application and you want to start up again when you get to the curve 

selection portion of the window you can click on the  button to designate which curve data you are 
wanting to download. This will activate the Open WITS Setting File window. 

 

16.) Highlight your saved file name and click on the button. 

17.) Click on the  button to close the Power*WITS application. 


